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Chapter 415

One-Sample T-Tests
for Non-Inferiority
Introduction
This procedure computes power and sample size for non-inferiority tests in one-sample designs in which the
outcome is distributed as a normal random variable. This includes the analysis of the differences between paired
values.
The details of sample size calculation for the one-sample design are presented in the One-Sample T-Tests chapter
and they will not be duplicated here. This chapter only discusses those changes necessary for non-inferiority tests.
Sample size formulas for non-inferiority tests of a single mean are presented in Chow et al. (2018) page 43.
The one-sample t-test is used to test whether a population mean is different from a specific value. When the data are
differences between paired values, this test is known as the paired t-test.

Paired Designs
Paired data may occur because two measurements are made on the same subject or because measurements are made
on two subjects that have been matched according to other variables. Hypothesis tests on paired data can be analyzed
by considering the difference between the paired items as the response. The distribution of differences is usually
symmetric. In fact, the distribution must be symmetric if the individual distributions of the two items are identical.
Hence, the paired t-test is appropriate for paired data even when the distributions of the individual items are not
normal.
In paired designs, the variable of interest is the difference between two individual measurements. Although the noninferiority hypothesis refers to the difference between two individual means, the actual values of those means are not
needed. All that is needed is their difference.

The Statistical Hypotheses
Both non-inferiority and superiority tests are examples of directional (one-sided) tests and their power and sample
size could be calculated using the One-Sample T-Tests procedure. However, at the urging of our users, we have
developed this procedure which provides the input and output options that are convenient for non-inferiority tests.
This section will review the specifics of non-inferiority testing.
Remember that in the usual t-test setting, the null (𝐻𝐻0 ) and alternative (𝐻𝐻1 ) hypotheses for one-sided upper-tail
tests are defined as
𝐻𝐻0 : 𝜇𝜇 ≤ 𝜇𝜇0

versus

𝐻𝐻1 : 𝜇𝜇 > 𝜇𝜇0

Rejecting 𝐻𝐻0 implies that the mean is larger than the value 𝜇𝜇0 . This test is called an upper-tail test because 𝐻𝐻0 is
rejected in samples in which the sample mean is larger than 𝜇𝜇0 .
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The lower-tail test is
𝐻𝐻0 : 𝜇𝜇 ≥ 𝜇𝜇0

versus

𝐻𝐻1 : 𝜇𝜇 < 𝜇𝜇0

Non-inferiority tests are special cases of the above directional tests. It will be convenient to adopt the following
specialize notation for the discussion of these tests.
Parameter
𝜇𝜇

PASS Input/Output Interpretation
𝜇𝜇
Population mean. If the data are paired differences, this is the mean of
those differences. This parameter will be estimated by the study.

𝜇𝜇0

𝜇𝜇0

Non-Inferiority Mean. This is the smallest (or largest) value of the mean
for which the new treatment will still be considered non-inferior to the
reference.

𝜇𝜇𝑅𝑅

𝜇𝜇𝜇𝜇

Reference value. Usually, this is the mean of a reference population. If
the data are paired differences, this is the hypothesized value of the mean
difference.

𝑀𝑀𝑁𝑁𝑁𝑁

NIM

Margin of non-inferiority. This is a tolerance value that defines the
magnitude of difference that is not of practical importance. This may be
thought of as the largest difference from the reference value that is
considered to be trivial. This value is assumed to be a positive number.

𝜇𝜇1

𝜇𝜇1

Actual population mean at which power is calculated. This is the
assumed population mean used in all calculations.

Non-Inferiority Tests
A non-inferiority test tests that the mean is not worse than that of the baseline (reference) population by more than
a small non-inferiority margin. The actual direction of the hypothesis depends on the whether higher values of the
response are good or bad.

Case 1: High Values Good
In this case, higher values are better. The hypotheses are arranged so that rejecting the null hypothesis implies that
the mean of the treatment group is no less than a small amount below the reference value. The value of 𝜇𝜇1 at
which power is calculated is often set to zero for paired tests.
Equivalent sets of the null and alternative hypotheses are
𝐻𝐻0 : 𝜇𝜇 ≤ 𝜇𝜇0

𝐻𝐻0 : 𝜇𝜇 ≤ 𝜇𝜇𝑅𝑅 − 𝑀𝑀𝑁𝑁𝑁𝑁

𝐻𝐻0 : 𝜇𝜇 − 𝜇𝜇𝑅𝑅 ≤ −𝑀𝑀𝑁𝑁𝑁𝑁

versus
versus
versus

Case 2: High Values Bad

𝐻𝐻1 : 𝜇𝜇 > 𝜇𝜇0

𝐻𝐻1 : 𝜇𝜇 > 𝜇𝜇𝑅𝑅 − 𝑀𝑀𝑁𝑁𝑁𝑁

𝐻𝐻1 : 𝜇𝜇 − 𝜇𝜇𝑅𝑅 > −𝑀𝑀𝑁𝑁𝑁𝑁

In this case, lower values are better. The hypotheses are arranged so that rejecting the null hypothesis implies that
the mean of the treatment group is no more than a small amount above the reference value. The value of 𝜇𝜇1 at
which power is calculated is often set to zero for paired tests.

Equivalent sets of the null and alternative hypotheses are
𝐻𝐻0 : 𝜇𝜇 ≥ 𝜇𝜇0

𝐻𝐻0 : 𝜇𝜇 ≥ 𝜇𝜇𝑅𝑅 + 𝑀𝑀𝑁𝑁𝑁𝑁

𝐻𝐻0 : 𝜇𝜇 − 𝜇𝜇𝑅𝑅 ≥ 𝑀𝑀𝑁𝑁𝑁𝑁

versus
versus
versus

𝐻𝐻1 : 𝜇𝜇 < 𝜇𝜇0

𝐻𝐻1 : 𝜇𝜇 < 𝜇𝜇𝑅𝑅 + 𝑀𝑀𝑁𝑁𝑁𝑁
𝐻𝐻1 : 𝜇𝜇 − 𝜇𝜇𝑅𝑅 < 𝑀𝑀𝑁𝑁𝑁𝑁
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Example
A non-inferiority test example will set the stage for the discussion of the terminology that follows. Suppose that a
test is to be conducted to determine if a new cancer treatment adversely affects the mean bone density. The
adjusted mean bone density (AMBD) in the population of interest is 0.002300 gm/cm with a standard deviation of
0.000300 gm/cm. Clinicians decide that if the treatment reduces AMBD by more than 5% (0.000115 gm/cm), it
poses a significant health threat.
The hypothesis of interest is whether the AMBD in the treated group is greater than 0.002300 – 0.000115 =
0.002185. The statistical test will be set up so that if the null hypothesis that the AMBD is less than or equal to
0.002185 is rejected, the conclusion will be that the new treatment is non-inferior, at least in terms of AMBD. The
value 0.000115 gm/cm is called the margin of non-inferiority.

One-Sample T-Test Statistic
The one-sample t-test assumes that the data are a simple random sample from a population of normallydistributed values that all have the same mean and variance. This assumption implies that the data are continuous
and their distribution is symmetric. The calculation of the t-test proceeds as follows
𝑡𝑡𝑛𝑛−1 =

where
𝑋𝑋� =

𝑋𝑋� − 𝜇𝜇0
𝑠𝑠⁄√𝑛𝑛

∑𝑛𝑛𝑖𝑖=1 𝑋𝑋𝑖𝑖
,
𝑛𝑛

∑𝑛𝑛 (𝑋𝑋𝑖𝑖 − 𝑋𝑋�)2
,
𝑠𝑠 = � 𝑖𝑖=1
𝑛𝑛 − 1

and 𝜇𝜇0 is the value of the mean hypothesized by the null hypothesis that incorporates both 𝜇𝜇𝑅𝑅 and 𝑀𝑀𝑁𝑁𝑁𝑁 .

The significance of the test statistic is determined by computing the p-value. If this p-value is less than a specified
level (usually 0.05), the hypothesis is rejected. Otherwise, no conclusion can be reached.

Power Calculation for the One-Sample T-Test
When the standard deviation is unknown, the power is calculated as follows for a directional alternative (onetailed test) in which 𝜇𝜇1 > 𝜇𝜇0 .

1. Find 𝑡𝑡𝛼𝛼 such that 1 − 𝑇𝑇𝑑𝑑𝑑𝑑 (𝑡𝑡𝛼𝛼 ) = 𝛼𝛼, where 𝑇𝑇𝑑𝑑𝑑𝑑 (𝑡𝑡𝛼𝛼 ) is the area under a central-t curve to the left of x and
df = n – 1.

2. Calculate: 𝑋𝑋1 = 𝜇𝜇0 + 𝑡𝑡𝛼𝛼

𝜎𝜎

√𝑛𝑛

.

3. Calculate the noncentrality parameter: 𝜆𝜆 =
4. Calculate: 𝑡𝑡1 =

𝑋𝑋1 −𝜇𝜇1
𝜎𝜎
√𝑛𝑛

+ 𝜆𝜆.

𝜇𝜇1 −𝜇𝜇0
𝜎𝜎
√𝑛𝑛

.

′
′
(𝑡𝑡1 ), where 𝑇𝑇𝑑𝑑𝑑𝑑,𝜆𝜆
(𝑥𝑥) is the area to the left of x under a noncentral-t curve with degrees
5. Power = 1 − 𝑇𝑇𝑑𝑑𝑓𝑓,𝜆𝜆
of freedom df and noncentrality parameter 𝜆𝜆.
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Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that will be of interest.

Solve For
Solve For
This option specifies the parameter to be calculated from the values of the other parameters. Under most
conditions, you would select either Power or Sample Size.
Select Sample Size when you want to determine the sample size needed to achieve a given power and alpha error
level.
Select Power when you want to calculate the power.

Test
Higher Means Are
This option defines whether higher values of the response variable are to be considered better or worse. The
choice here determines the direction of the non-inferiority test.
•

Better (H1: μ > μ0)
If higher means are Better the null hypothesis is H0: μ ≤ μ0, and the alternative hypothesis is H1: μ > μ0.
μ0 = μR - NIM, where μR is the baseline, standard, or reference mean and NIM is the margin of noninferiority.

•

Worse (H1: μ < μ0)
If higher means are Worse the null hypothesis is H0: μ ≥ μ0, and the alternative hypothesis is H1: μ < μ0.
μ0 = μR + NIM, where μR is the baseline, standard, or reference mean and NIM is the margin of noninferiority.

Population Size
This is the number of subjects in the population. Usually, you assume that samples are drawn from a very large
(infinite) population. Occasionally, however, situations arise in which the population of interest is of limited size.
In these cases, appropriate adjustments must be made.
When a finite population size is specified, the standard deviation is reduced according to the formula:
𝑛𝑛
𝜎𝜎12 = �1 − � 𝜎𝜎 2
𝑁𝑁
where n is the sample size, N is the population size, 𝜎𝜎 is the original standard deviation, and 𝜎𝜎1 is the new
standard deviation.
𝑛𝑛

The quantity n/N is often called the sampling fraction. The quantity �1 − � is called the finite population
𝑁𝑁
correction factor.
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Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected.
Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents
the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size
N (Sample Size)
This option specifies one or more values of the sample size, the number of individuals in the study. This value
must be an integer greater than one. You may enter a list of values using the syntax 50 100 150 200 250 or 50 to
250 by 50.

Effect Size – Means
μ0 (Non-Inferiority Mean)
Enter a value (or range of values) for the non-inferiority mean. Since higher means are worse, this is the largest
value of the mean for which the new treatment will still be considered non-inferior to the reference.
Define μR as the baseline, standard, or reference mean and NIM as the margin of non-inferiority. When higher
means are better, the non-inferiority mean is calculated as μ0 = μR - NIM and μ0 can be any number that satisfies
μ0 < μ1. When higher means are worse, the non-inferiority mean is calculated as μ0 = μR + NIM and μ0 can be
any number that satisfies μ0 > μ1.
μ1 (Actual Mean)
Enter a value (or range of values) for the actual mean at which power and sample size are calculated. Care should
be taken that this value is consistent with whether higher means are better or worse. μ1 > μ0 when higher means
are better. μ1 < μ0 when higher means are worse.

Effect Size – Standard Deviation
σ (Standard Deviation)
This option specifies one or more values of the standard deviation. This must be a positive value. Be sure to use
the standard deviation of X and not the standard deviation of the mean (the standard error). If you are doing a
paired test, this is the standard deviation of the differences.
When this value is not known, you must supply an estimate of it. PASS includes a special tool for estimating the
standard deviation. This tool may be loaded by pressing the SD button. Refer to the Standard Deviation Estimator
chapter for further details.
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Example 1 – Power Analysis
Suppose that a test is to be conducted to determine if a new cancer treatment adversely affects the mean bone
density. The adjusted mean bone density (AMBD) in the population of interest (𝜇𝜇𝑅𝑅 ) is 0.002300 gm/cm with a
standard deviation of 0.000300 gm/cm. Clinicians decide that if the treatment reduces AMBD by more than 5%
(𝑀𝑀𝑁𝑁𝑁𝑁 = 0.000115 gm/cm such that 𝜇𝜇0 = 𝜇𝜇𝑅𝑅 − 𝑀𝑀𝑁𝑁𝑁𝑁 = 0.002185), it poses a significant health threat. They also
want to consider what would happen if the margin of non-inferiority is set to 2.5% (0.0000575 gm/cm such that
𝜇𝜇0 = 𝜇𝜇𝑅𝑅 − 𝑀𝑀𝑁𝑁𝑁𝑁 = 0.0022425).

Following accepted procedure, the analysis will be a non-inferiority test using the t-test at the 0.025 significance
level. Power is to be calculated assuming that the new treatment has no effect on AMBD. Several sample sizes
between 20 and 300 will be analyzed. The researchers want to achieve a power of at least 90%. All numbers have
been multiplied by 10000 to make the reports and plots easier to read.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the One-Sample T-Tests for Non-Inferiority procedure window by expanding Means, then One
Mean, then clicking on Non-Inferiority, and then clicking on One-Sample T-Tests for Non-Inferiority. You
may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and
choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Higher Means Are ................................... Better (H1: μ > μ0)
Population Size ....................................... Infinite
Alpha ....................................................... 0.025
N (Sample Size)...................................... 20 40 60 80 100 150 200 300
μ0 (Non-Inferiority Mean) ........................ 21.85 22.425
μ1 (Actual Mean) .................................... 23
σ (Standard Deviation) ........................... 3

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
Higher Means are Better
Hypotheses: H0: μ ≤ μ0 vs. H1: μ > μ0

Power
N
0.36990
20
0.65705
40
0.83164
60
0.92317
80
0.96682
100
0.99658
150
0.99970
200
1.00000
300
0.12601
20
0.21844
40
0.30873
60
0.39493
80
(report continues)

Non-Inferiority
Mean
μ0
21.850
21.850
21.850
21.850
21.850
21.850
21.850
21.850
22.425
22.425
22.425
22.425

Actual
Mean
μ1
23.000
23.000
23.000
23.000
23.000
23.000
23.000
23.000
23.000
23.000
23.000
23.000

Standard
Deviation
σ
3.0
3.0
3.0
3.0
3.0
3.0
3.0
3.0
3.0
3.0
3.0
3.0

Alpha
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025

Beta
0.63010
0.34295
0.16836
0.07683
0.03318
0.00342
0.00030
0.00000
0.87399
0.78156
0.69127
0.60507
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Report Definitions
Power is the probability of rejecting the null hypothesis when it is false. It should be close to one.
N is the sample size, the number of subjects (or pairs) in the study.
μ0 = μR - NIM is the non-inferiority mean since higher means are better, where μR is the baseline, standard,
or reference mean and NIM is the margin of non-inferiority.
μ1 is the actual value of the population mean at which power and sample size are calculated.
σ is the standard deviation of the response (or standard deviation of differences for paired data). It
measures the variability in the population.
Alpha is the probability of rejecting the null hypothesis when it is true, which is the probability of a false
positive.
Beta is the probability of accepting the null hypothesis when it is false, which is the probability of a false
negative.
Summary Statements ─────────────────────────────────────────────────────────
A sample size of 20 achieves 37% power to detect non-inferiority using a one-sided one-sample
t-test when the non-inferiority mean is 21.850 and the actual mean is 23.000. The data are
drawn from a single population with an estimated standard deviation of 3.0. The significance
level (alpha) of the test is 0.025.
Chart Section ──────────────────────────────────────────────────────────────

The above report shows that for 𝜇𝜇0 = 21.85 (NIM = 1.15), the sample size necessary to obtain 90% power is just
under 80. However, if 𝜇𝜇0 = 22.425 (NIM = 0.575), the required sample size is about 300.
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Example 2 – Finding the Sample Size
Continuing with Example 1, the researchers want to know the exact sample size for each value of 𝜇𝜇0 .

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the One-Sample T-Tests for Non-Inferiority procedure window by expanding Means, then One
Mean, then clicking on Non-Inferiority, and then clicking on One-Sample T-Tests for Non-Inferiority. You
may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and
choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Higher Means Are ................................... Better (H1: μ > μ0)
Population Size ....................................... Infinite
Power ...................................................... 0.90
Alpha ....................................................... 0.025
μ0 (Non-Inferiority Mean) ........................ 21.85 22.425
μ1 (Actual Mean) .................................... 23
σ (Standard Deviation) ........................... 3

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results ────────────────────────────────────────────────────────────
Higher Means are Better
Hypotheses: H0: μ ≤ μ0 vs. H1: μ > μ0

Power
0.90215
0.90005

N
74
288

Non-Inferiority
Mean
μ0
21.850
22.425

Actual
Mean
μ1
23.000
23.000

Standard
Deviation
σ
3.0
3.0

Alpha
0.025
0.025

Beta
0.09785
0.09995

This report shows the exact sample size requirement for each value of 𝜇𝜇0 .
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Example 3 – Validation using Chow, Shao, Wang, and Lokhnygina
(2018)
Chow, Shao, Wang, and Lokhnygina (2018) page 46 has an example of a sample size calculation for a noninferiority t-test where 𝜇𝜇𝑅𝑅 = 1.5 and 𝑀𝑀𝑁𝑁𝑁𝑁 = 0.5. Their example obtains a sample size of 8 when 𝜇𝜇1 = 2, 𝜇𝜇0 = 1,
σ = 1, Alpha = 0.05, and Power = 0.80.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the One-Sample T-Tests for Non-Inferiority procedure window by expanding Means, then One
Mean, then clicking on Non-Inferiority, and then clicking on One-Sample T-Tests for Non-Inferiority. You
may then make the appropriate entries as listed below, or open Example 3 by going to the File menu and
choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Higher Means Are ................................... Better (H1: μ > μ0)
Population Size ....................................... Infinite
Power ...................................................... 0.80
Alpha ....................................................... 0.05
μ0 (Non-Inferiority Mean) ........................ 1
μ1 (Actual Mean) .................................... 2
σ (Standard Deviation) ........................... 1

Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
Higher Means are Better
Hypotheses: H0: μ ≤ μ0 vs. H1: μ > μ0

Power
0.81502

N
8

Non-Inferiority
Mean
μ0
1.0

Actual
Mean
μ1
2.0

Standard
Deviation
σ
1.0

Alpha
0.050

Beta
0.18498

PASS also obtains a sample size of 8.
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Example 4 – Validation of a Cross-Over Design given in Julious
(2004)
Julious (2004) page 1953 gives an example of a sample size calculation for a cross-over design. His example
obtains a sample size of 87 when 𝜇𝜇1 = 0, 𝜇𝜇0 = -10 (NIM = 10), σ = 28.28427, Alpha = 0.025, and Beta = 0.10.
When 𝜇𝜇1 is changed to 2, the resulting sample size is 61. Note that 𝜇𝜇1 represents a difference in this case and 𝜇𝜇𝑅𝑅 =
0.
Note that in Julius’s example, the population standard deviation is given as 20. Assuming that the correlation
between items in a pair is 0, the standard deviation of the difference is calculated to be
𝜎𝜎 = �202 + 202 − 0(20)(20) = 28.284271. Actually, the value of σ probably should be less because the
correlation is usually greater than 0 (at least 0.2).

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the One-Sample T-Tests for Non-Inferiority procedure window by expanding Means, then One
Mean, then clicking on Non-Inferiority, and then clicking on One-Sample T-Tests for Non-Inferiority. You
may then make the appropriate entries as listed below, or open Example 4 by going to the File menu and
choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Higher Means Are ................................... Better (H1: μ > μ0)
Population Size ....................................... Infinite
Power ...................................................... 0.90
Alpha ....................................................... 0.025
μ0 (Non-Inferiority Mean) ........................ -10
μ1 (Actual Mean) .................................... 0 2
σ (Standard Deviation) ........................... 28.284271

Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
Higher Means are Better
Hypotheses: H0: μ ≤ μ0 vs. H1: μ > μ0

Power
0.90332
0.90323

N
87
61

Non-Inferiority
Mean
μ0
-10.0
-10.0

Actual
Mean
μ1
0.0
2.0

Standard
Deviation
σ
28.3
28.3

Alpha
0.025
0.025

Beta
0.09668
0.09677

PASS also obtains sample sizes of 87 and 61.
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Example 5 – Validation of a Cross-Over Design given in Chow,
Shao, Wang, and Lokhnygina (2018)
Chow, Shao, Wang, and Lokhnygina (2018) page 59 gives an example of a sample size calculation for a crossover design. Their example calculates sample sizes of 13 and 14 (13 by normal approximation formula and 14
from their table for the t-test) in each sequence (26 or 28 total) when 𝜇𝜇1 = -0.1, 𝜇𝜇0 = -0.2 (NIM = 0.2),
σ = 0.2, Alpha = 0.05, and Beta = 0.20. Note that 𝜇𝜇1 represents a difference in this case and 𝜇𝜇𝑅𝑅 = 0.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the One-Sample T-Tests for Non-Inferiority procedure window by expanding Means, then One
Mean, then clicking on Non-Inferiority, and then clicking on One-Sample T-Tests for Non-Inferiority. You
may then make the appropriate entries as listed below, or open Example 5 by going to the File menu and
choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Higher Means Are ................................... Better (H1: δ > -NIM)
Population Size ....................................... Infinite
Power ...................................................... 0.80
Alpha ....................................................... 0.05
NIM (Non-Inferiority Margin) ................... 0.2
δ1 (Actual Difference, μ1 - μ0) ............... -0.1
σ (Standard Deviation) ........................... 0.2

Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
Higher Means are Better
Hypotheses: H0: μ ≤ μ0 vs. H1: μ > μ0

Power
0.81183

N
27

Non-Inferiority
Mean
μ0
-0.2

Actual
Mean
μ1
-0.1

Standard
Deviation
σ
0.2

Alpha
0.050

Beta
0.18817

PASS obtains a sample size of 27, which is between the values of 26 and 28 that were obtained by Chow et al.
(2018)
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